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NOTIFICATION OF THIRD-PARTY LICENSES

Oracle Utilities software contains third party, open source components as identified below. Third- party license
terms and other third-party required notices are provided below.

License: Apache 1.1

Module: Crimson v1.1.1, Xalan ]2

Copyright © 1999-2000 The Apache Software Foundation. All rights reserved.

Use of Crimson 1.1.1 and Xalan J2 within the product is governed by the following (Apache 1.1):

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/or other matetials provided with the
distribution. (3) The end-user documentation included with the redistribution, if any, must include the
following acknowledgment: “This product includes software developed by the Apache Software Foundation
(http:/ /www.apache.org/) . Alternately, this acknowledgment may appear in the software itself, if and
wherever such third-party acknowledgments normally appear. (4) Neither the component name nor Apache
Software Foundation may be used to endorse or promote products derived from the software without specific
prior written permission. (5) Products derived from the software may not be called “Apache”, nor may
“Apache” appear in their name, without prior written permission.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES,
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OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

License: CoolServlets.com

Module: CS CodeViewer v1.0 (Sun JRE Component)

Copyright © 1999 by CoolServlets.com

Use of this module within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/ot other matetials provided with the
distribution. (3) Neither the component name nor Coolservlets.com may be used to endorse or promote
products derived from the software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY COOLSERVLETS.COM AND CONTRIBUTORS “AS IS” AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."

License: Justin Frankel, justin@nullsoft.com
Module: NSIS 1.0j (Sun JRE Component)
Use of this module within the product is governed by the following:

(1) The origin of the module must not be misrepresented, and Oracle may not claim that it wrote the original
software. If Oracle uses this module in a product, an acknowledgment in the product documentation is
appreciated but not required. (2) Altered source versions of the module must be plainly marked as such, and



must not be misrepresented as being the original software. (3) The following notice may not be removed or
altered from any source distribution: “Justin Frankel justin@nullsoft.com”.

License: ICU4j License
Module: ICU4j
Copyright © 1995-2001 International Business Machines Corporation and others. All rights reserved.

Oracle may use the software without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, and/or sell copies of the software, and to permit persons to whom the software is
furnished to do so, provided that the above copyright notice and the permission notice appear in all copies of
the software and that both the above copyright notice and the permission notice appear in supporting
documentation.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY
RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS
NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.

License: Info-ZIP

Module: INFO-ZIP ZIP32.DLL (Binary Form)

Copyright (c) 1990-2005 Info-ZIP. All rights reserved

Use of this dll within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
definition and disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the definition and disclaimer below in the documentation and/or other materials
provided with the distribution. The sole exception to this condition is redistribution of a standard UnZipSFX
binary (including SFEXWiz) as part of a self-extracting archive; that is permitted without inclusion of this
license, as long as the normal SFX banner has not been removed from the binary or disabled. (3) Altered
versions--including, but not limited to, ports to new operating systems, existing ports with new graphical
interfaces, and dynamic, shared, or static library versions--must be plainly marked as such and must not be
misrepresented as being the original source. Such altered versions also must not be misrepresented as being
Info-ZIP releases--including, but not limited to, labeling of the altered versions with the names “Info-ZIP” (or
any variation thereof, including, but not limited to, different capitalizations), “Pocket UnZip,” “WiZ” or
“MacZip” without the explicit permission of Info-ZIP. Such altered versions are further prohibited from
mistepresentative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s). (4) Info-ZIP
retains the right to use the names “Info-ZIP,” “Zip,” “UnZip,” “UnZipSFX,” “WiZ,” “Pocket UnZip,” “Pocket
Zip,” and “MacZip” for its own source and binary releases.

[Definition]: For the purposes of this copyright and license, “Info-ZIP” is defined as the following set of
individuals:

Mark Adler, John Bush, Karl Davis, Harald Denker, Jean-Michel Dubois, Jean-loup Gailly, Hunter Goatley, Ed
Gordon, Ian Gorman, Chris Herborth, Dirk Haase, Greg Hartwig, Robert Heath, Jonathan Hudson, Paul
Kienitz, David Kirschbaum, Johnny Lee, Onno van der Linden, Igor Mandrichenko, Steve P. Miller, Sergio
Monesi, Keith Owens, George Petrov, Greg Roelofs, Kai Uwe Rommel, Steve Salisbury, Dave Smith, Steven
M. Schweda, Christian Spieler, Cosmin Truta, Antoine Verheijen, Paul von Behren, Rich Wales, Mike White

[Disclaimer:] “This software is provided “as is,” without watranty of any kind, express or implied. In no event
shall Info-ZIP or its contributors be held liable for any direct, indirect, incidental, special or consequential
damages arising out of the use of or inability to use this software.”

License: Paul Johnston
Modules: md5.js
Copyright (C) Paul Johnston 1999 - 2002

Use of these modules within the product is governed by the following:



(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/or other materials provided with the
distribution. (3) Neither the component name nor the names of the copyright holders and contributors may be
used to endorse or promote products derived from the software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 1S”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

License: Jef Poskanzer

Modules: DES, 3xDES (Sun JRE Components)

Copyright © 2000 by Jef Poskanzer <jef@acme.com>. All rights reserved
Use of these modules within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/or other matetials provided with the
distribution. (3) Neither the component name nor the name of Jef Poskanzer may be used to endorse or
promote products derived from the software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

License: Sun Microsystems, Inc.

Modules: Sun Swing Tutorials

Copyright© 1995-2006 Sun Microsystems, Inc. All Rights Reserved.
Use of these modules within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/or other matetials provided with the
distribution. (3) Neither the component name nor the name of Sun Microsystems, Inc. and contributors may
be used to endorse or promote products derived from the softwate without specific prior written permission.
(4) Oracle must acknowledge that the software is not designed, licensed or intended for use in the design,
construction, operation or maintenance of any nuclear facility.

THIS SOFTWARE IS PROVIDED “AS1S,” WITHOUT A WARRANTY OF ANY KIND. ALL EXPRESS
OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY
IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR
NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. (“SUN”) AND ITS
LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A
RESULT OF USING, MODIFYING OR DISTRIBUTING THIS SOFTWARE OR ITS DERIVATIVES.
IN NO EVENT WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT
OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR



PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF
LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THIS SOFTWARE, EVEN IF
SUN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

License: Tom Wu

Module: jsbn library

Copyright © 2003-2005 Tom Wu. All rights reserved

Use of this module within the product is governed by the following:

(1) Redistributions of source code must retain the above copyright notice, this list of conditions and the
disclaimer below. (2) Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the disclaimer below in the documentation and/or other matetials provided with the
distribution.

THE SOFTWARE IS PROVIDED “AS-1IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL TOM
WU BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES
OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY
THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.



Contents

Chapter 1

What is Oracle Utilities Transaction Management? ........ccc.ee....
What is this BOOK? ......ccoiiieiiiriciiricnciecscccece
International and Multiple Currency Support

Locales and Languages
Date and Numeric Presentation

Currency Presentation ..o

Multiple Currency Support
File Formats

Database Support

Chapter 2

Working with the Oracle Utilities Energy Information Platform
Starting the Application and Logging In

Navigating The Oracle Utilities Energy Information Platform ..o 2-3
FLAMEWOIK cooviieitct s 2-3
IMLEIIUS .ottt ittt et Rt 2-4
INAVIGATION ..ttt 2-5

Searching, Viewing, and Entering Data in the Oracle Utilities Energy Information Platform.........ccccccceeuucec. 2-6
Searching and VIewing DAta ..ot
ENtering Data ..o

RUN REPOLLS 1ottt s bbb bbb ias
Scheduling REPOLLS ...t

VIEW REPOITS ..ottt ab bbb
REPOIE ICOMS ottt
Viewing Oracle BI Publisher REPOLLS.......coiuuiiriciiiriniiiciiicicisecinicetcc s
Viewing Oracle Utilities Rules Language Reports

Emailing Reports

Chapter 3

Searching and Viewing Oracle Utilities Transaction Management Data
Search Inbound and Outbound DOCUMENLS ... saes

Viewing Inbound/Outbound Document Data

DEtals TAD ...t

Exceptions Tab

Search Processes

Viewing Process Data
DIELAILS TAD 1.ttt ettt ettt bbb b s ba bbbt e ettt et eteae st eretenen
Transactions Tab
Exceptions Tab .........

Search Transactions ..................

Viewing Transaction Data........
Details Tab.................
Tasks Tab



EXCEPHONS TAD ..ttt e et 3-12
INOES TAD ...t 3-12
Search REGUESTS/RESPONSES wouvuvuimiucieiiiieririeierieisetsetsetsetsetse ettt saeeie s ea st st s esiessessessesseaesseseans 3-13
Search Document DOWNIOAAS ... 3-14

Chapter 4

Searching and Viewing Exceptions
Search Exceptions ........ccccuneee

SYStEM BEXCEPLONS vttt bbb

Chapter 5

Oracle Utilities Transaction Management SEtUpP......cccceiveivienienieiniiiniinienienieeieerensesiesssessssesssesssessesses

Transaction Management Business RUIES.........coiiiiiiiiiiiiii s
Global Functions .......cc.ccceeevviuninee.
Rule Description Language ...............
Business Rules ..o

Transaction Management Components
SEIVErS. o
JMS Servers
JMS Queues
Payload TYPES ...cciiiiiiii s
EXCEPHON TYPES wovvviiviiiiiiiiiiiiii bbb
OFIINAION SYSTEMIS co.uiviiiiiiiiiiiiiiict bbb
SYStEM PLOPEITIES..c.uviiviiiiiiiiiiciici e
Trading Partners ..o s
External Transaction TYPES......ciiiiiiiiiiiis s
EXternal HUDS......cii s
External Hub ACHVAtION. ..o

Transaction Management SEIVICES......cviiiiiiiiii s
RUNTIME SEIVICES..ouviiiiiiiiiiiiiii e
Service Activation .....
XSLT Map Names........
XSLT Map Versions
XOLT MAPS covitiiiiiiisciisssi st

Chapter 6

Oracle Utilities Transaction Management REPOILS ....ccueevvueeiiiiiiiieiiiiiiiiieenieiniieneeesirecsesessseeesseesssssesnns 6-1
Transaction Details REPOTt ... s 6-2
Exception Details REPOTt. ..o 6-3
Transaction Control REPOTt. ... 6-4

Index



Chapter 1

Overview

This chapter provides an overview of Oracle Utilities Transaction Management user interface,
including:

*  What is Oracle Utilities Transaction Management?
*  What is this book?

* International and Multiple Currency Support
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What is Oracle Utilities Transaction Management?

What is Oracle Utilities Transaction Management?

Oracle Ultilities Transaction Management is a web-enabled user interface that provides access to
process and transaction data used by Oracle Ultilities Transaction Management. Because all Oracle
Utilities web applications share a common framework, users can switch between different Oracle
Utilities web applications (such as Oracle Utilities Billing Component) without having to open
multiple applications.

Important Note
Before you can use Oracle Utilities Transaction Management, you must ensure that appropriate
process and transaction data and records have been created in the Oracle Utilities Data
Repository. The instructions in this user guide assume that these records exist. For more
information about creating, updating, or editing records, see the Oracle Utilities Transaction
Management Installation and Confignration Guide.

1-2 Transaction Management User’s Guide



What is this book?

What is this book?

The Oracle Utilities Transaction Management Web User’s Guide describes the Oracle Ultilities
Transaction Management functionality, including the following:

Chapter 1: Overview provides an overview of the Oracle Ultilities Transaction Management
web application.

Chapter 2: Working with the Oracle Utilities Energy Information Platform describes
how users work with the Oracle Utilities Energy Information Platform web interface,
including information about general navigation and common controls. Also this chapter
describes how to run and view the results of a number of Oracle Utilities Transaction
Management reports.

Chapter 3: Searching and Viewing Oracle Utilities Transaction Management Data
describes how to search and view different types of Oracle Utilities Transaction Management
data, including documents, processes and transactions, and requests and responses.

Chapter 4: Searching and Viewing Exceptions describes how to search and view
exceptions.

Chapter 5: Oracle Utilities Transaction Management Setup describes the reports
provided with Oracle Ultilities Transaction Management.
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International and Multiple Currency Support

International and Multiple Currency Support

This section outlines international and multiple currency support in the Oracle Utilities Energy
Information Platform, including:

*  Locales and Languages

*  Date and Numeric Presentation
*  Cutrency Presentation

*  Multiple Currency Support

*  File Formats

*  Database Support

Locales and Languages

Two fundamental concepts undetlying international support in Oracle Utilities applications are
languages and locales. Languages determine the specific language in which text labels and
controls of an application appear. Locales determine the specific region or country in which the
user is working. Specifically, locales are used to specify display and input formatting for:

*  Date/time and numeric presentation, and
*  Currency presentation

How a user selects a language and/or locale is determined by the type of application being used.

Web-enabled Products

For web-enabled products, a uset’s locale and language are selected from the Locales tab of the
Set Preferences screen. The selected locale and language are stored in the uset’s security
properties. The available locales on this screen are specified in the LOCALES.CFG. XML
configuration file (see Chapter 2: Configuration Files in the Oracle Utilities Energy Information
Platform Configuration Guide for more information). Locales included in the LOCALES.CFG. XML
file must also be installed on the web server and be accessible from the Regional Settings Control
Panel. If a selected locale is not installed on the web setrver, currency formatting and presentation
may be incorrect.

If a user does not select a locale (or selects a locale of “None”), the default locale is the Server
System Locale (defined by the operating system installed on the web server). Oracle Utilities
recommends that all users specify a locale before using internationalized applications.

Client/Server Products
For client/setver products, the uset’s locale is determined by the Regional Settings of the client
and/or application server machine.

Languages
The language for client/setver products is specified using a command line switch and/or a
parameter in the LODESTAR.CFG file. See Oracle Utilities Application Command Line
Parameters on page 4-11 in the Oracle Utilities Energy Information Platform Installation Guide for more
information about command line parameters. See LODESTAR.CFG on page 2-2 in the Oracle
Utilities Energy Information Platform Configuration Guide for more information about the
LODESTAR.CFG file. At this time, available languages include English, French, German, and
Ttalian.
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International and Multiple Currency Support

Reports
For client/setver applications, the locale for reports is determined by the Regional Settings of the
machine on which the report is run.

For web-enabled applications, the locale for reports is based on the Server System Locale (defined
by the operating system installed on the web server)

Languages
For client/setver applications, the language that appeats on teports is determined by the language
of the application that generated the report, specified either by a command line parameter or a
configuration file parameter.

For web-enabled applications, the language is specified by the Regional Settings of the machine
on which the report is run, unless overridden by the LANGUAGE parameter in the
LODESTAR.CFG file.

Date and Numeric Presentation

The display and input of dates and numbers is based on the selected locale.

Web-enabled products

Display formatting of both numbers and date/times is based on the uset's selected locale.

Copy, cut, and paste operations are supported for all input controls. Required fields are identified
by asterisks. Null values are represented by blank (empty) controls. Moving the mouse pointer
over an input area displays sample formatting for that field.

Number input controls only accept formatting based on the user's selected locale. The only
allowable characters include digits, decimal separator, and minus sign. Any other characters are
filtered from input.

Date input controls only accept formatting based on the user's selected locale. Dates can either be
keyed in or selected from a pop-up calendar control. All times are keyed in and based on 24 hour
format (no AM or PM indicator).

Input validation occuts upon data entry.

Client/Server Products
Formatting for numbers and date/times is based on the locale determined by the regional settings
of the client and/or application server machine. Date/time formatting can be ovetridden from the
General Options tab of the Default Options dialog.

Reports
Display formatting of both numbers and date/times for reports is based on the Server System
Locale on the machine on which the reports are run.

Currency Presentation

Currency information is stored in the LSCurrency table in the Oracle Utilities Data Repository.
This table contains one or more currencies, each defined by a currency code, currency symbol, and
formatting rules (such as the number of decimal places). Currency codes in this table use ISO-
4217 codes. The LSCurrency table also indicates the Default currency for the database. See
LSCurrency on page 3-3 in the Oracle Utilities Energy Information Platform Configuration Guide for
more information about setting up the LSCurrency table.

Note: Although records in the LSCurrency table are not required, Oracle Utilities strongly
recommends that at least one record with all properties specified be created and set as “Default”.
This will ensure consistent display of currency information.
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International and Multiple Currency Support

Currency Presentation in Oracle Utilities Receivables Component and Oracle
Utilities Quotations Management

Currency input and display is identical to that for numbers with two exceptions:

* A currency indicator is also displayed next to currency input controls and currency displays.
The specific currency symbol displayed and the manner in which currency is formatted are
determined in the following order:

a.  The currency associated with the account being viewed (from the LSCurrency field in
the Account table).

b.  The default currency in the LSCurrency table. If there is no default currency, the first
record in the LSCurrency table (sorted alpha-numerically by Currency Code).

b. If the LSCurrency table is not present or does not contain any records, the currency and
formatting of the Server System Locale (defined by the operating system installed on the
web setver),specified in the HKEY_USERS\.DEFAULT\ Control
Panel\International key in the Windows Registry on the web setver.

*  Currency formatting rules for the uset's selected locale are overridden if specific formatting
rules for the currency are stored in the LSCurrency table. Typically, the only formatting rules
that would be overridden at the currency level would be the ISO code, symbol, and number
of decimal places. This applies to Oracle Utilities Receivables Component reports as well,
except that the initial locale formatting rules come from the regional settings of the machine
on which the report is run.

Currency Presentation in Other Web-enabled Products
Currently, other web-enabled products do not require input of currency values.

Display of currencies is based on the formatting of the selected locale and of the default currency
in the database (currency specific formatting always overrides locale specific formatting).

Enabling Display of International Currency Symbols
Display of international currency symbols requites the appropriate Encoding option is selected on
Internet Explorer.

How to select encoding options:

1. Select View->Encoding from the Internet Explorer menu bar.

2. Select the appropriate option from the list. For example, to enable displaying of the Euro
symbol and other Western European currency symbols, select the Western European
(Windows) option.

Currency Presentation in Client/Server Products
Client/servet products do not requite input of cutrency values.

Display of currencies is based on the formatting of the client machine's regional settings and of
the default currency in the database. Currency specific formatting always overrides locale specific
formatting. If the default currency in the database does not specify any formatting, the currency
symbol is used for formatting. If the currency table does not exist or does not contain any records
then the default cutrency is determined by the Regional Settings on the client/server machine.
This applies to reports as well.
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International and Multiple Currency Support

Multiple Currency Support

Multiple Currency Support allows for accounts with different associated currencies. This is
accomplished through the presence of the Currency Code column on the Account, Journal
Account, and Checking Account tables in the Oracle Utilities Data Repository. This column
references records in the LSCurrency table

Multiple Currency and Oracle Utilities Receivables Component
All input screens which have amount fields on them indicate what currency type is expected as
input.

All elements that represent a curtency in Oracle Utilities Receivables Component XML structures
have a CURRENCY attribute that indicates the corresponding currency type for the amount. The
string values used for this attribute are the same as the Currency Code values in the LSCurrency
table. On output, the CURRENCY attribute is set for the account as specified in the database. If
the account's currency type is not specified in the database, the default currency is used.

A CURRENCY attribute (using the standard stem.tail notation) is supported for Oracle Ultilities
Receivables Component transaction identifiers to specify the currency type for the account.

On input, the CURRENCY attribute of all Oracle Ultilities Receivables Component transactions is
checked against the currency value of the account against which the transaction is being posted
using the following rules:

1. Ifa currency type is specified for the account in the database, the transaction must indicate
the same currency type or it is an error.

2. If a cutrency type is not specified for the account in the database, the transaction must
indicate either no specific currency type or the default currency type for the database or it is
an error.

All transactions that involve two or more accounts (such as Payment and Balance Transfers)
validate that the currency types are the same for each account (no currency translation will occur).
The credit/debit account pairs for each journal translation record are validated to ensure that they
both have the same currency type. Only journal translation records that have credit/debit
accounts with the same currency type as the account against which the transaction is being posted
are used. Additional currency validations occur for payment files and refund checks.

Multiple Currency and Oracle Utilities Receivables Component Reports
Where applicable, Oracle Utilities Receivables Component reports are grouped by Currency Code.

Multiple Currency and Other Oracle Utilities Products
Oracle Ultilities Billing Component, Oracle Utilities Rate Management and Data Manager reports
display the Currency Code associated with each account where applicable. Reports that contain
multiple currency types do not include the Summary Results page.

In Oracle Utilities Rate Management - Revenue Forecasting, the default currency type is used for
all presentation of currency amounts, regardless of whether or not a specific currency has been
indicated in the database for any accounts.
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International and Multiple Currency Support

File Formats

Input/Output File Formats
Numbets and date/times in input and output files (such as files used with the PLIMPORT
program) are independent from locale settings.

Non-English charactets are suppotted in input/output files.

XML Formats

All dates, times, and numbers contained in XML files are represented using the standard
formatting rules as defined by the W3C XML Schema Recommendation. For backward
compatibility, previously accepted formats for dates and times will continue to be accepted on
input, however, all output will use the XML Schema representation.

Note: XML files created by the SAVE TO XML Rules Language statement are
an exception. The date, time, and number formats in Rules Language generated
XML files are based on the Rules Language configuration used to create them.

Non-English characters are supported in XML files

Database Support

In addition to the LSCurrency table and related columns in the Account, Journal Account, and
Checking Account tables, database support for internationalization includes the addition of the
COUNTRY column in the Address table and the change from ZIP Code to Postal Code on user
interfaces.
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Chapter 2

Working with the Oracle Utilities Energy
Information Platform

This chapter describes how you work with the Oracle Utilities applications. This includes:
*  Starting the Application and Logging In
*  Navigating The Oracle Utilities Energy Information Platform

*  Searching, Viewing, and Entering Data in the Oracle Utilities Energy Information
Platform

*  Run Reports

*  View Reports
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Starting the Application and Logging In

You log on to Energy Information Platform using Microsoft Internet Explorer.

How to log in:

1. Start the application by double-clicking the shortcut icon, or entering the URL for the Oracle
Utilities Energy Information Platform in the Address field on the Internet Explorer window.

Note: Contact your system administrator for the URL for the Oracle Utilities Energy
Information Platform.

2. The Login screen appeats.

3. Enter your user ID in the User ID field, enter your password in the Password field, and click
Login. The Energy Information Platform home dashboard screen appears in the browser.
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Navigating The Oracle Utilities Energy Information Platform

Framework

This section describes the framework of the Oracle Ultilities Energy Information Platform and
how to use the menus and icons to navigate between functions including:

¢  Framework
¢ Menus

* Navigation

The Energy Information Platform is a web-based framework, consisting of the Top menu, the
Left menu, and the Main Workspace.

Top Menu

The Top menu displays a number of menu items, including:
*  Home: Returns the user to the home dashboard screen.
*  Help: Expands to display the following:

*  Content and Index: Opens Online Help window for the current option or function (if
applicable).

*  Online Support: Opens the Oracle Ultilities website in the Main Workspace.

*  About: Opens the About dialog, which displays the user’s current preferences and the
software version installed.

*  Logout: Logs the user out of the Energy Information Platform, ends the current session, and
returns the user to the Login screen.

Left Menu
The Left menu displays menu options available to the user. This menu can be set to one of two
modes: the Main menu or the Data menu. The bottom of the Left menu displays a number of
icons. The meanings of these icons are as follows:

Icon Description

5 Default Menu: Changes the Left menu from the Main Menu to
2 the Data Menu.

Default Menu: Changes the Left menu from the Data Menu to
the Main Menu.

I:I Current Data Base: Opens the Set Preferences screen. When
you hover the mouse over this icon, a tool tip opens, displaying
currently selected data source.

= Security Administration: Opens the Security Administration
A
& screen.
> Home: Returns the user to the home dashboard screen.

Change Theme: Opens the Change Theme dialog.

Working with the Oracle Utilities Energy Information Platform 2-3



Main Menu

The Main menu opens by default, and lists the functions available from the Energy Information

Platform. Clicking on a menu item displays the corresponding screen in the Main Workspace on

the right. A down-pointing arrow at the left of a menu choice indicates that the choice has

associated submenu items below it. To open the submenu list, click on the arrow. The arrow

becomes a right-pointing arrow, and the submenu options are displayed below the menu item.

Data Menu

Note: The options that appear on the Main menu are dependent on the
specific set of products licensed and installed.

The Data menu lists database tables accessible via the Data Navigator, which allows users to

search, add, view, and edit database records and tables in the Oracle Utilities Data Repository. See
Chapter 8: Searching and Viewing Data in the Oracle Utilities Data Repository in the Oracle
Utilities Energy Information Platform User’s Guide for more information about Data Navigator.

Main Workspace
The center of the window is occupied by the Main Workspace, which holds the screen

corresponding to the selected function.

Menus

As noted above, the Main menu includes a number of submenus, each relating to a specific activity

or product. Oracle Utilities Transaction Management uses the following menus:

Transaction Management Menu
The Transaction Management menu includes the following options:

*  Search: Expands to display the Oracle Utilities Transaction Management Search menu, which
includes the following options:

Inbound/Outbound: Opens the Search Inbound and Outbound Documents
screen.

Processes: Opens the Search Processes screen.

Transaction: Opens the Search Transaction screen.
Request/Response: Opens the Search Requests/Responses screen.
Exceptions: Opens the Search Exceptions screen.

System/Token: Opens the System Exceptions screen.

Document Download: Opens the Document Download screen.

*  Set Up: Expands to display the Oracle Utilities Transaction Management Set Up menu,
which includes the following options.

Business Rule: Opens the Business Rule screen.

Rule Description Language: Opens the Rule Description Language screen.
Global Functions: Opens the Global Functions screen.

LTMH/Adapter Setrvers: Opens the LTMH/Adapter Servers screen.

JMS Servers: Opens the JMS Servers screen.

JMS Queues: Opens the JMS Queues screen.

Payload Types: Opens the Payload Types screen.

Exception Types: Opens the Exception Types screen.
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*  Origination Systems: Opens the Origination Systems screen.

*  System Properties: Opens the System Properties screen.

*  Runtime Services: Opens the Runtime Services screen.

*  Service Activation: Opens the Service Activation screen.

*  Map Names: Opens the Map Names screen.

*  Map Versions: Opens the Map Versions screen.

*  Maps: Opens the Maps screen.

*  Trading Partners: Opens the Trading Partners screen.

*  External Transaction Types: Opens the External Transaction Types screen.
*  External Hubs: Opens the External Hubs screen.

*  External Hub Activation: Opens the External Hub Activation screen.

*  Run Reports: Opens the Run Reports screen, displaying reports associated with
Transaction Management (Product code “LTMH”).

*  View Reports: Opens the View Reports screen, listing previously run reports associated
with Transaction Management (Product code “LTMH?”).

Navigation

Oracle Utilities recommends using links and menu options when moving between screens in the
Energy Information Platform. Use of the Internet Explorer Forward and Back buttons can
produce unexpected results.
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Searching, Viewing, and Entering Data in the Oracle Utilities
Energy Information Platform

This section describes how users search, view, and enter data in the Energy Information Platform,

and includes:
*  Searching and Viewing Data

*  Entering Data

Searching and Viewing Data

This section provides specific information about searching and viewing data in the Energy
Information Platform, including:

Searching
When searching records, users enter data in each of the fields they wish to use in their search. See
Entering Data below for more information about how to enter specific types of data. If a search
returns only one record, the record itself is displayed instead of the list screen.

Specifying How Results are Sorted
To specify how search results are sorted, click the Sort by plus (“+”) sign. This opens a pop-up
window that lists the fields that can be used to sort the search results.

To sort by a specific field(s), check the corresponding checkbox(s). By default, records are sorted
in ascending order (denoted by the . arrow). To sort records in descending order, click the
arrow. The & arrow will be replaced by the = arrow.

To change the order by which the search results are sorted, click on the s area and move the
field to the appropriate position in the list.

After specifying how the results are to be sorted, click the Sort by minus (*-”) sign to close the list.

For example, if a user were searching accounts and wanted to sort the results first by Customer ID
in ascending order, and then by Start Time in descending order, the user would first check the
Customer ID checkbox, then check the Start Time checkbox and click the & arrow.

Note that sorting settings are reset each time you perform a search.

Viewing Search Results
Search results appear on a list screen that displays the records that match the search criteria. Each
item on the list contains the entite record. Use the horizontal scroll bar to view columns that
appear to the right of the list screen.

Sorting Search Results
Search results are sorted as specified by the user (see Specifying How Results are Sorted
above). The direction (ascending or descending) in which each column is sorted is displayed at the
top of each column.

Columns sorted in ascending order display a blue arrow pointing up.

To change the direction in which the results are sorted, click the up (ascending) or down
(descending) arrow at the top of the appropriate column on the list screen.
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To continue the above example, if a user had searched accounts and sorted the results first by
Customer ID in ascending order, and then by Start Time in descending order, the Customer ID
column would display a blue arrow pointing up ( . ) and the Start Time column would display a
red arrow pointing down ().

Locking Columns

Entering Data

Some columns on search results list screens can be locked, or “pinned” in place, keeping the
identity of the search results visible at all times. As the user scrolls to the right using the horizontal
scroll bar, locked columns remain in place, while non locked columns scroll “beneath” the locked
column(s).

Columns that can be locked have a pin button (§§) on them.

To lock a column, click the pin button (45). This rotates the pin button, indicating that the column
is locked.

To unlock a column, click the pin button (4g) again.

This section provides specific information about entering data in the Energy Information
Platform screens, including:

*  Entering Date and Date/Time Values
*  Entering Lookup Values
*  Selecting Values from Drop-Down Lists

*  Specific Data Formats

Entering Date and Date/Time Values

Date and Date/Time fields store dates and/or datetimes, such as Start Date, Start Time, and Bill
Month values. To enter date/time values, either type the date and time manually, or click the arrow

button (EI) to the right of the field and select the date using the calendar control.

The calendar control displays the current month when opened. Click the appropriate day to select
it. To change the month, click the arrows on either side of the month displayed. To change the
year, click the arrows on cither side of the year displayed. To select the current date, click Today.
To clear the date value, click Cleat.

Note: When entering dates manually, use the four digit format (i.e. “2004”).

Note: When you select a date using the calendar control, the time defaults to
00:00:00.

Entering Lookup Values

Lookup values are references to records in other tables in the Oracle Utilities Data Repository,
including both lookup records such as Operating Company and Jurisdiction records, and parent
records such as Customer or Account records. When populated, lookup fields display the identity

of the referenced record. To select a lookup, click the Browse button ( ,,,). This opens a dialog

window that lists all the records in the corresponding table in the Oracle Utilities Data Repository.

If there is more than one page of records, you can move between pages using the 4 and P .

buttons. Use the Ml button to return the first page, and the M button to navigate to the last
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page. To change the number of results that appears on each page, enter the number in the Rows
field and press the Enter key.

To search for a specific record, click Search. The dialog displays a search screen.

Enter the appropriate parameters for your search and click Search. The dialog will display a list of
records that match the search criteria.

Click the [...] link to select the appropriate record. The lookup field is automatically populated.

Selecting Values from Drop-Down Lists
Drop-down lists allow users to select a value from a pre-populated list, and can contain either pre-
set values or values from tables in the Oracle Utilities Data Repository.

To select a value from a drop-down list, click the arrow next to the field. This opens a lists that
includes all the values available.

Account Status | A

IWCTIVE
FIMAL

Z

If one or more of the values is longer than the default size of the list, click the lower right corner
of the list and resize the list as necessary.

Specific Data Formats
Some fields on some screens of the Energy Information Platform require that data be entered in a
specific format. This most often applies to currency and date fields, but can also apply to other
number fields and other types of data. Moving the mouse pointer over the icon displays a tooltip
that contains the correct format for the field.

Mumber of Installments:

|
0 <= -HH#H <= 1000000000000000, ot required|
Installment Amount. § |

If data is entered in an incorrect format, the border of the field turns red indicating that there is an
error in the data in the field. Moving the mouse pointer over the field displays a tooltip that
describes the correct format for the field.

Installment Armount § | 200.000] Recg
B, Hi <= 1000000000000000, rot required]|
T

First Installment Amount; § !E"U" 0=

Required Fields

Fields that are required are indicated by an asterisk (¥).

Currency Fields
Currency fields are indicated by a currency symbol to the left of the field.
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Run Reports

The Run Reports option displays teports available through the Energy Information Platform

Reporting Framework. From this screen, users can select and run reports. Each product has its

own Run Reports option that displays reports associated with that product. For example, the

Oracle Utilities Billing Component list displays billing reports, while the Oracle Utilities

Receivables Component reports list displays it’s reports.

How to run reports:

1.

Select the Run Reports option from the appropriate menu (Tools and Utilities, Work
Queues, Billing, Financials, etc.). The Run Reports screen opens.

The Run Reports screen displays the following information for each report:
*  Report Name: The name of the report.

*  Description: A description of the report.

*  Priority: The priority of the report (High, Medium, or Low).

*  Type: The type of report (PLBX, LSRate (Oracle Utilities Rules Language), Active, or
BIPublisher).

*  Output Format: The output format for the report (applies to reports of type
“BIPublisher” only).

*  Creation Date: The date the report template was created.
*  User: The User ID who created the report template.

*  Generate ASP: A flag that indicates if the report framework generates an ASP
parameters page for the report.

Select the report you wish to run by clicking the Report Name link from the list.

The Enter Report Parameters screen opens displaying the report parameters for the
selected report.

Enter the parameters for the report as appropriate.

The Report Title ficld is the title that appears on the View Reports screen when the report
is run.

Select the Priority for the report. This determines the priority (High, Medium, or Low) in
which the report will be generated.

Uncheck the Shared Report checkbox if you wish to make the results of the report private. If
you leave this checkbox checked, the report results will be available to all users.

Click Run to run the report. Click Schedule Report to schedule the report using the
Schedule Process screen (see Scheduling Reports below, for more information). When the
report is complete, the report opens in the appropriate viewer (Active, etc.). In addition, the
report is also listed on the View Reports screen.

How to search reports:

1.

Click New Search on the Run Reports screen. The Run Reports search screen appears.

You can search based on the Report Name, Report Type, User ID (who created the report or
who last updated the report), Output Format, Creation Date, Priority, Report Category,
Product, or the report Description.

You can search for reports whose creation dates are Less Than (<), Greater Than (>), Less
Than or Equal To (<=), or Greater Than or Equal To (>=) the supplied date by selecting the
appropriate operand from the drop-down list.
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You can use the percent sign (“%”) as a wildcard character when entering values in any of the
text fields. For instance, if you want to search for all reports whose name begins with the
letter G, you could enter “G%"” in the Name field. You can use this wildcard before or after
specified letters or numbers (i.e. you would use %t to search for all reports whose names end
with the letter t, etc.).

Note that account Report Names, User IDs, and Descriptions are case-insensitive. For
example, there is no difference between the “WQAging” and “wqaging” report names.

2. Specify how the search results are displayed.

*  Select the manner in which the results are sorted from the Sort By: drop-down list. You
can sort the results by Creation Date, Description, Report Name, Report Type, or User
1D.

*  Specify how many results should appear on each page in the Page Length field.
3. Click Search to perform the search. To clear all the search fields, click Reset.

4. 'The search results appear on the Run Reports screen.

Scheduling Reports

The Schedule Process screen allows users to define a schedule for running processes unattended.

How to schedule a process:
1. Click Schedule (or Schedule Report). The Schedule Process screen opens.

2. Enter the Start Time for the scheduled process by entering the date and time manually or
clicking the arrow and select the date using the calendar control and typing the time manually.
See Entering Date and Date/Time Values on page 2-8 for more information about using
the calendar control.

Note: The Server Time displayed above the Start Time field is the current time of the web
server running the scheduler, including both the location and Time Zone where the server is
located. Scheduled processes run based on the server time, not the time on the client
machine.

3. Select a Recurrence Pattern for the scheduled process. You can select one of the following:

None: The scheduled process runs only once at the specified start time. Note: Scheduled
processes with a recurrence pattern of None ignore Business Calendars and will run on non-
business days.

Intra Daily: The scheduled process runs multiple times, from as frequent as once every 15
minutes to once every several hours. To base the recurrence on a number of minutes, select
the Every x minutes radio button and select the number from the Minutes drop-down list.
To base the recurrence on a number of hours, select the Every x hours radio button and
enter the number of hours in the text box. Intra Daily processes may run throughout a single
day or may span multiple days.

Daily: The scheduled process runs once per day or once per number of days. To base the
recurrence on a number of days, select the Every x days radio button and enter the number
of days in the text box. To set the scheduled process to run every weekday, check the Every
weekday radio button.

Weekly: The scheduled process runs once or more per week (or number of weeks) on
specified days. Enter the number of weeks in the Recur every x week(s) on text box, and
check the specific days of the week on which the process should run. For example, to
schedule a process to run on Monday and Wednesday every two weeks, you would enter 2 in
the Recur every x week(s) on text box and check the Monday and Wednesday checkboxes.

Monthly: The scheduled process runs once per month or once per number of months. A
monthly recurrence can be based on either a specific day of the month (such as the the 10th
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day of the month), or a specific type of day (such as the 2nd Friday of the month). To base the
recurrence on a specific day, select the Day x of every x month(s) radio button and enter the
specific day and number of months in the text boxes. To base the recurrence on a specific
type of day, select the The x x of every x month(s) radio button and select the appropriate
number (First, Second, Third, Fourth, or Last) and day (Sunday through Saturday) from the
drop-down lists and enter the number of months in the text box.

Important Note: Each execution of a recurring scheduled process uses the original
parameters entered for the process.

Set the Range of Recurrence for the scheduled process. This specifies how many times the
scheduled process will run (based on the specified recurrence pattern). There are three
options:

*  No end date: To specify no ending date for the recutrence, select the No end date
radio button.

*  End after occurence: To specify that the recurrence ends after a predetermined
numbet, select the End after occurrence radio button and enter the number of
recurrences in the text box.

*  End by: To specify a date on which to end the recurrences, select the End by radio
button and enter the date and time by which the recurrence should end. Enter the date
and time manually or click the arrow and select the date using the calendar control and
type the time manually. See Entering Date and Date/Time Values on page 2-8 for
more information about using the calendar control.

Set any applicable Recurrence Exceptions for the scheduled process. Recurrence
exceptions define which business calendar, if any, is used in scheduling and how to handle
processes scheduled to run on non-business days. There are two options:

*  Business Calendar: To schedule the process using a business calendar, click the Browse
button ( ...). This opens a dialog window that lists all the available Business Calendars.
Click the [...] link to select the appropriate calendar. The field is automatically populated.

*  Roll to next business day: Check this checkbox to specify that a process scheduled to
run on a non-business day is rolled forward to the next business day. If the process is
already scheduled to run on the next business day, a new process is NOT scheduled.

Note: When using a Business Calendar, if the Start Time entered for a process is later than
the last date in the Business Calendar, an error will be returned. Also, for scheduled processes
with the No End Date option selected, occurrences that would have occurred on dates later
than the last date in the Business Calendar will not occur, and do not appear on the View
Reports screen.
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View Reports

The View Reports option displays previously run reports available through the Energy

Information Platform Reporting Framework, including other processes such as uploading data via

the Upload Usage option. From this screen, users can view and delete reports. Each product has
its own View Reports option that displays reports associated with that product. For example, the
Oracle Utilities Billing Component View Reports screen displays billing reports, while the Oracle

Utilities Receivables Component View Reports screen displays it’s reports.

How to view reports:

1. Select the View Reports option from the appropriate product menu (Tools and Utilities,
Work Queues, Billing, Financials, etc.) The View Reports screen opens.

The View Reports screen displays the following information for each report:

Status Icon: An icon that displays the status of the report. If an output format was
specified for the report, the icon indicates the output format. See Report Icons for
more information.

Run/Schedule Time: The time the report was run or is scheduled to run.

Report Title: The title of the report, specified when the report was run. For LSRate
(Oracle Utilities Rules Language) reports, this column will display the name of the
Report Template used to generate the repott, unless specified using the
SETREPORTTITLE Rules Language function.

Priority: The priority of the report (High, Medium, or Low).

Type: The type of report (PLBX (Oracle Utilities Billing Component), LSRate (Oracle
Utilities Rules Language), Active, or BIPublisher).

User: The user ID of the user who ran the report.

Progress: The current percentage of the report instance that has been generated, from 0
to 100 percent.

Shared: A flag that indicates if the report is shared by all users or is accessible only by
the user who ran the report.

Base: A flag that indicates if the report is provided by Oracle Ultilities or is a custom
report.

Process: The (machine) name of the server on which the report was executed.
Account Name: The name of the account associated with the report, if applicable.

Account ID: The ID of the account associated with the report, if applicable.

2. To view a specific report, click the Report Title link for the report. The selected report
opens in the appropriate viewer.

3. To refresh the contents of the screen, click Refresh Periodically. To have the screen
continually refresh its contents, check the Refresh Periodically checkbox.

Note: The current state of the Refresh Periodically checkbox (selected or not) is stored in the
user’s settings, and is used as the default setting when subsequently opening this screen.

How to delete reports:

1. Check the checkbox next to the reports(s) to delete. To select all reports, check the top check

box.

2. Click Delete.

How to search reports:

1. Click New Search on the View Reports screen. The View Reports search screen appears.
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Report Icons

You can search based on the Report Title, Report Type, User ID (who created the report),
Output Format, Creation Date, Report Category, or Product.

You can search for reports whose creation dates are Less Than (<), Greater Than (>), Less
Than or Equal To (<=), or Greater Than or Equal To (>=) the supplied date by selecting the
appropriate operand from the drop-down list.

You can use the percent sign (“%”) as a wildcard character when entering values in any of the
text fields. For instance, if you want to search for all reports whose name begins with the
letter G, you could enter “G%” in the Name field. You can use this wildcard before or after
specified letters or numbers (i.e. you would use %t to search for all reports whose names end
with the letter t, etc.).

Note that account Report Titles, User IDs, and Descriptions are case-insensitive.
Specify how the search results are displayed.

*  Select the manner in which the results are sorted by clicking the Sort by plus (“+”) sign.
See Specifying How Results are Sorted on page 2-7 for more information.

*  Specify how many results should appear on each page in the Page Length field.
Click Search to perform the search. To clear all the search fields, click Reset.

The search results appear on the View Reports screen.

The icon listed next to each report indicates the status of the report. The meanings of these icons
are as follows:

Icon Description

Report Starting: Report processing is starting.

Report in Process: Report processing

Report Complete: Report processing is complete.

Report Complete (Adobe Acrobat format): Report processing is
complete.

Report Complete (Microsoft Excel format): Report processing is
complete.

W E R %

Report Complete (Microsoft Word format): Report processing is
complete.

¥

Report Complete (Rich Text format): Report processing is com-
plete.

=

Report Complete (Comma Separated Values format): Report pro-
cessing is complete.

i

Report Scheduled: Report is scheduled to run at a future time. To

]

view scheduling details, click the ¥ atrrow in the far right column.
To edit the schedule, click Edit.

Tl

ﬁ-’ Report Reminder: Indicates that a scheduled report is due to run
in 15 minutes or less.
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Icon Description

& Report Error: One or more errors or warnings associated with the
report. To view the error, click the Error icon.

Viewing Oracle Bl Publisher Reports

When you select an Oracle BI Publisher Report, the report opens in a viewer based on the output
format defined for the report. For the default output formats, this includes:

¢ Adobe Acrobat
¢  Microsoft Excel

*  Microsoft Word (for MS Word and Rich Text Format reports. If Microsoft Word is not
installed, Rich Text Format reports open in the installed application (if any) associated with
the *.rtf file extension).

Viewing Oracle Utilities Rules Language Reports

When you select a Oracle Utilities Rules Language Report (one with a Type of LSRate), the report
opens in the Report view screen.

The State section above the top left corner of the report displays the state of the report, including
the number of Errors, the number of Pages expected and ready, and the elapsed time (in seconds)
it took for the report to run.

State:  Errors 0 Pages: 32 ewpected, 32 ready, 15 elapzed

The From: and To: fields above the top right corner of the report show the current pages

displayed. The From: field displays the current page. The 4 and P buttons and the field
between them are used to navigate the report. The field between the buttons defines how many
pages display in the report window at a time. The default is 1. To display more than one page at a
time, enter the number of pages you wish to view in the field.

Emailing Reports
You can also email reports from the View Reportts screen. This allows users to distribute reports

to other parties via email.

Note: The Send Email function requires the presence of the LSRELAY.CFG.XML file in the
C:\LODESTAR\CFG directory on the web setver computer. Contact your system administrator
for more information about this file.

How to email a report:

1. Select the report (or reports) you wish to send via email and click Send Email on the View
Reports screen.

The Send Email screen opens.

2. Select a From address from the drop-down list. This list is based on available records in the
From Addresses table. If there are no available records in the From Addresses table, the
current user’s email address is populated (if provided on the User Overview screen on the
Security Adminstration user interface).

3. Enter an email address in the To field, or click Address Book (or the “+” sign) to add a
contact or group name. See Using the Address Book on page 2-15 for more information
about using the Address Book.
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Optional. Enter an email address in the CC field, or click Address Book (or the “+” sign) to
add a contact or group name. See Using the Address Book on page 2-15 for more
information about using the Address Book.

To remove the CC field, click Remove CC.

Optional. To add the BCC field, click Add BCC, and enter an email address in the BCC field,
or click Address Book (or the “+” sign). See Using the Address Book on page 2-15 for
more information about using the Address Book.

Enter a subject for the email in the Subject field.
Enter the email message in the Message field.
To send the email, click Send. To clear all the fields, click Reset.

A message will appear at the top of the View Reports screen after your email has been sent.

View Reports Mew Search | Delete | Send Email

o vour email has been sent.

[T Refresh Perindically [T Show Scheduled Reports

Using the Address Book

In addition to entering email addresses manually, you can use the Address Book feature to select
email recipients from those defined in the Oracle Utilities Data Repository. The Address Book
contains listings of:

Contacts

Contacts

Groups

Contacts are specific individuals related to parties (such as Service Points or Market Participants)
defined in the Oracle Utilities Data Repository.

How to select an existing contact from the Address Book:

1.

Click Address Book (or the “+” sign) on the Send Email screen.
The Address Book dialog opens on the Contacts tab.

Enter the search criteria for the contacts you wish to send email to. You can search by Last
Name, First Name, Middle Name, or Company.

Specify how the search criteria are to be combined by selecting the appropriate Combine
with option (AND or OR), located in the upper right corner of the search screen. The
default combine option is AND.

Specify whether or not the search is Case-sensitive by checking or unchecking the Case-
sensitive checkbox, located in the upper right corner of the search screen. The default setting
is case-sensitive.

Specify how the search results are displayed.

*  Select the manner in which the results are sorted by clicking the Sort by plus (“+”) sign.
See Specifying How Results are Sorted on page 2-7 for more information.

*  Specify how many results should appear on each page in the Page Length field.

Click Search to petform the search. To reset the search fields to theit previous values, click
Reset. To clear all the search fields, click Cleat. To add a new contact to the Address Book,
click Add.

The search results appear on the Address Book dialog.
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Select the contact(s) you wish to send the email to and click To. The selected contact(s) will
appear in the To field on the Send Email screen.

To remove a contact from the To, CC, or BCC field, select the contact and click the Delete
Key, or click the right mouse, and select Remove.

Optional. To add a contact to the CC (or BCC) field, select the contact(s) you wish to send the
email to and click CC (or BCC as appropriate). The selected contact(s) will appear in the CC
(or BCC) field on the Send Email screen.

How to add a contact using the Address Book:

1.

N vk

Click Add on the Contacts tab of the Address Book dialog.
The Edit Contact screen opens.

Enter personal information for the contact (First, Middle, and Last Names, Title, etc.) in the
Personal Information pane.

Enter contact methods (phone numbers, email addresses, etc.) for the contact in the Contact
Method pane.

Enter optional address(es) for the contact in the Address Information pane.
Click Save to save the contact.
Click Return to Email to return to the Send Email screen and Address Book dialog.

Select the new contact and click To, CC, or BCC to add the contact to the appropriate field.

See Contacts on page 7-2 in the Oracle Utilities Energy Information Platform User’s Guide for more
information about creating contacts.

Groups

Groups are groupings of contacts in the Oracle Ultilities Data Repository.

How to select an existing group from the Address Book:

1.

Click Address Book (or the “+” sign) on the Send Email screen.
The Address Book dialog opens on the Contacts tab. Click the Groups tab.

Enter the search criteria for the contacts you wish to send email to. You can search by Group
Name or Desciption.

Specify how the search criteria are to be combined by selecting the appropriate Combine
with option (AND or OR), located in the upper right corner of the search screen. The
default combine option is AND.

Specify whether or not the search is Case-sensitive by checking or unchecking the Case-
sensitive checkbox, located in the upper right corner of the search screen. The default setting
is case-sensitive.

Specify how the search results are displayed.

*  Select the manner in which the results are sorted by clicking the Sort by plus (“+”) sign.
See Specifying How Results are Sorted on page 2-7 for more information.

*  Specify how many results should appear on each page in the Page Length field.

Click Search to perform the search. To reset the search fields to their previous values, click
Reset. To clear all the search fields, click Clear. To add a new group to the Address Book,
click Add.

The search results appear on the Address Book dialog.

Select the group(s) you wish to send the email to and click To. The selected group(s) will
appear in the To field on the Send Email screen.
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To remove a group name from the To, CC, or BCC field, select the group name and press the
Delete key, or click the right mouse, and select Remove.

Optional. To add a group to the CC (or BCC) field, select the group(s) you wish to send the
email to and click CC (or BCC as appropriate). The selected group(s) will appear in the CC
(or BCC) field on the Send Email screen.

How to add a group using the Address Book:

1.

6.
7.
8.

Click Add on the Groups tab of the Address Book dialog.
The Edit Group screen opens.

Enter a name for the group in the Group Name field.
Enter a description of the group in the Description field.

Optional. Check the Is Private checkbox to indicate that the group is private. Private groups
can be only be viewed by the user who created the group. Public groups (Is Private
unchecked) can be viewed by all users.

To add a contact to the group, click Add on the Membership title bar, and select the contact
from the Contact ID drop-down list. Repeat this step for each contact you wish to add to the

group.
Click Save to save the group.

Click Return to Email to return to the Send Email screen and Address Book dialog.

Select the new group and click To, CC, or BCC to add the group to the appropriate field.

See Groups on page 7-5 in the Oracle Utilities Energy Information Platform User’s Guide for more
information about creating contact groups.
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Chapter 3

Searching and Viewing Oracle Utilities

Transaction Management Data

Oracle Ultilities Transaction Management allows users to search for and view information about

selected inbound and outbound documents, processes and transactions, and requests and
responses. This chapter describes how to search and view this data, including:

Search Inbound and Outbound Documents
Viewing Inbound/Outbound Document Data
Search Processes

Viewing Process Data

Search Transactions

Viewing Transaction Data

Search Requests/Responses

Search Document Downloads
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Search Inbound and Outbound Documents

The Search Inbound/Outbound option allows usets to seatch for Oracle Utilities Transaction
Management inbound and outbound documents in the Oracle Utilities Data Repository based on
vatious search criteria. Inbound and outbound documents contain transactions.

How to search inbound and outbound documents:

1.

Select Transaction Management->Seatch->Inbound/Outbound.

The Search Inbound/Outbound window opens.

Select whether to search for Inbound or Outbound documents in the Search box.
To search archived documents, check the Archive checkbox.

Select or enter the search criteria in the appropriate field.

You can select the Sender, Receiver, Payload Type, Status Code, and FA Status Code
associated with the document.

You can also search based on Doc Ref ID and source by entering the appropriate value
associated with the document. Note that Doc Ref IDs and Sources are case-sensitive. For
example, there is a difference between the “USER_1" and “user_1” IDs.

You can also search based on the date the process ot transaction was sent/received by
enteting dates in the Date Sent/Received ficlds.

Select the manner in which the results are sorted from the Order By: drop-down list. You
can sort the results by Sent/Received Date or Status of the document.

Specify how many results should appear on each page in the Page Length field.

Click Search to start the search. To reset all fields to their default values, click Reset. To clear
all the search fields, click Clear.

The search results appear in the Inbound or Outbound Search Results windows.

The Inbound (or Outbound) Search Results window displays the following information for
each document:

e Inbound/Outbound Source
e DocRefID

*  Payload Type

. Status
¢ FA Status
e Sender ID

*  Receiver ID

*  Total Accepted

*  Total Rejected

*  Received Date

* Inbound File Name

To sort the results by one of the columns, click the appropriate column heading. For example,
to sort the results by Inbound Source, click the Inbound Source column heading. If there is

more than one page of results, you can move between pages using the 4 and P buttons. To
change the number of results that appears on each page, enter the number in the Rows field.
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9. To view a document, click on the view icon (@) Data for the selected process or
transaction will appear in the Inbound (or Outbound) Document window. See Viewing
Inbound/Outbound Document Data on page 3-4 for more information.

10. To perform another search, click New Search.
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Viewing Inbound/Outbound Document Data

Inbound and outbound document data is viewed from the Inbound Document and Outbound

Details Tab

Document windows. These window open when you select a document from the Inbound (or

Outbound) Search Results windows. The Inbound (or Outbound) Document window includes

two

The

tabs:
Details Tab

Exceptions Tab

Details tab displays basic information about a selected process, including:

Source: The source of the document.

Doc Ref IF: The reference ID for the document.

Sender ID: The ID of the sender.

Receiver ID: The ID of the receiver.

Transaction Accepted: The number of transactions in the document that were accepted.
File Name: The path and file name of the document.

Payload Type: A description of the process.

Status: The status of the document.

FA Status: The FA status of the document.

Received: The date/time on which the document was received

Transactions Rejected: The number of transactions in the document that were rejected.

Transactions Accepted List Box: A list of the transactions from the document that were
accepted. Each transaction listed includes the following:

*  Transaction Name

*  Transaction Type

*  External Transaction Type
*  Transaction Ref ID

e Status

¢ Date Sent

e Start Time

*  Stop Time

Click Refresh to refresh the process data displayed.

Click on one of the transactions in the Transactions Accepted list box to view data for the
selected transaction. See Viewing Transaction Data on page 3-11 for more information.

Click View Payload to view payload data for the document.

Click View FA Payload to view FA payload data for the document (if applicable).
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Exceptions Tab
The Exceptions tab displays a list of exceptions associated with the document, including:
*  Exception Date: The date the exception occurred.
*  Source: The source of the exception (i.e. where the exception occurred).

*  Message: The exception message.
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Search Processes

The Search Process option allows users to search for Oracle Utilities Transaction Management

processes in the Oracle Ultilities Data Repository based on various search criteria.

How to search processes:

1.

Select Transaction Management->Search->Processes.

The Search Processes window opens.

Select or enter the search criteria in the appropriate field.

You can select the Process Type, Process Name, or Status Code associated with the process.

You can also search based on Sender ID, Receiver ID, Internal Acct#, or External Acct# by
entering the appropriate value associated with the process. Note that Sender IDs, Receiver
IDs, Internal Acct#s, and External Acct#s are case-sensitive. For example, there is a
difference between the “USER_1" and “user_1"" Sender IDs.

You can also search based on dates associated with the process. To search based on the date
the process was sent, enter the dates in the Date Sent fields. To search based on the date the
process was Started or Stopped in Oracle Utilities Transaction Management, enter the dates
in the Date Started/Stopped in Oracle Utilities Transaction Management fields.

Select the manner in which the results are sorted from the Order By: drop-down list. You
can sort the results by Start Time, Stop Time, or Status of the process.

Specify how many results should appear on each page in the Page Length field.

Click Search to begin the search. To reset all the fields to their default values, click Reset. To
clear all the search fields, click Clear.

The search results appear in the Process Search Results windows.

The Process Search Results window displays the following information for each process:
*  Process Name

*  Process Type

*  Location

*  Status

*  Start Time

*  Stop Time

To sort the results by one of the columns, click the appropriate column heading. For example,
to sort the results by Process Name, click the Process Name column heading. If there is more

than one page of results, you can move between pages using the 4 and P buttons. To
change the number of results that appears on each page, enter the number in the Rows field.

To view a process, click on the view icon a) Data for the selected process will appear in
the Process window. See Viewing Process Data on page 3-7 for more information.

To perform another search, click New Search. To refresh the contents of the Search Results
window, click Refresh.
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Viewing Process Data

Details Tab

Transactions Tab

Process data is viewed from the Process window. This window opens when you select a process
from the Process Search Results window. The Process window includes three tabs:

¢ Details Tab
e  Transactions Tab
*  Exceptions Tab

Note: For processes that have a Status of ERROR, you can click the Terminate link to terminate
the process from any of these tabs.

The Details tab displays basic information about a selected process, including:

*  Name: The name of the process.

*  Type: The process type.

*  Status: The status of the process.

*  Start: The process start time.

*  Stop: The process stop time. If the process is currently running, the stop time is Null.
*  Description: A description of the process.

*  Diagram: A graphical depiction of the process consisting of a series of color-coded boxes
connected by black or red lines. Each box tepresents a transaction in the process. The color
of a particular box indicates the current status of the transaction. Black lines between
transactions indicate a successful path between the transactions. Red lines indicate a failure at
some point between the transactions.

*  Click Status Code Legend to open a window that lists the colors and their
cotresponding color codes.

Click Refresh to refresh the process data displayed.

Click on one of the transaction boxes in the diagram to view data for the selected transaction. See
Viewing Transaction Data on page 3-11 for more information.

The Transactions tab displays a list of transactions associated with the process. This list includes
the same information as the Transaction Search Results window.

To view a specific transaction, click on the view icon (@) See Viewing Transaction Data on
page 3-11 for more information.
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Exceptions Tab

The Exceptions tab displays a list of exceptions associated with the process, including:

Transaction Name: The name of the transaction associated with the exception.
Sent Date: The date the transaction was sent.

Exception Date: The date the exception occurred.

Exception Source: The source of the exception (i.e. where the exception occurred).
ID: The ID of the exception.

Exception Type: The type of exception.

Exception Description: A description of the exception.

Message: The exception message.

To view the transaction, click on the view icon a) See Viewing Transaction Data on page 3-
11 for more information.
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Search Transactions

The Search Transactions option allows users to search for Oracle Utilities Transaction
Management processes and transactions in the Oracle Ultilities Data Repository based on various

search criteria.

How to search transactions:

1.

Select Transaction Management->Search->Transactions.
The Search Transaction window opens.
Select or enter the search criteria in the appropriate field.

You can select the Transaction Type, Transaction Name, Status Code, or Exception
associated with the transaction.

You can also search based on Sender ID, Receiver ID, Internal Acct#, External Acct#, or
Trans Ref ID by selecting/entering the approptiate value associated with the transaction.
Note that Sender IDs, Receiver IDs, Trans Ref IDs, Internal Acct#s, and External Acct#s are
case-sensitive. For example, there is a difference between the “USER_1” and “user_1"
Sender IDs.

You can also search based on dates associated with the transaction. To search based on the
date the transaction was sent, enter the dates in the Date Sent fields. To search based on the
date the transaction was Started or Stopped in Oracle Utilities Transaction Management,
entet the dates in the Date Started/Stopped in Oracle Utilities Transaction
Management fields.

Select the manner in which the results are sorted from the Order By: drop-down list. You
can sort the results by Start Time, Stop Time, or Status of the transaction.

Specify how many results should appear on each page in the Page Length field.

Click Search to begin the search. To reset all the fields to their default values, click Reset. To
clear all the search fields, click Clear.

The search results appear in the Transaction Search Results windows.

The Transaction Search Results window displays the following information for each
process:

*  Transaction Name

*  Transaction Type

*  Status

*  Location

*  Date Sent

*  External Transaction Type
*  Transaction ID

*  Jurisdiction

*  Receiver ID

*  Sender ID

*  Clearing House ID

*  External Account Number
* Internal Account Number

*  From System (the system that sent the transaction)
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e Start Time
*  Stop Time

7. To sort the results by one of the columns, click the appropriate column heading. For example,
to sort the results by Transaction Name, click the Transaction Name column heading. If there

is more than one page of results, you can move between pages using the 4 and F buttons.
To change the number of results that appears on each page, enter the number in the Rows
field.

8. To view a transaction, click on the view icon (%) Data for the selected transaction will
appear in the Transaction window. See Viewing Transaction Data on page 3-11 for more
information.

9. To perform another search, click New Search. To refresh the contents of the Search Results
window, click Refresh.
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Viewing Transaction Data

Details Tab

Transaction data is viewed from the Transaction window. This window opens when you select a
transaction from the Transaction Search Results window or the Details or Transactions tabs of the
Process window. The Transaction window includes the following tabs:

*  Details Tab

* Tasks Tab

*  Exceptions Tab
*  Notes Tab

Note: For transactions that have a Status of ERROR, you can click Resubmit, Override, or
Terminate to resubmit, override, or terminate the transaction from any of these tabs.

The Details tab displays basic information about a selected transaction, including:
*  Name: The name of the transaction.

*  Status: The status of the transaction.

*  Transaction Type: The transaction type.

*  Jurisdiction: The jurisdiction associated with the transaction.

*  From System: The system that sent the transaction.

*  Type: External transaction type.

*  Transaction ID: ID of the transaction.

*  Clearing House ID: ID of

*  Sender ID: ID of the sender of the transaction.

*  Receiver ID: ID of the recipient of the transaction.

*  Sent: The date on which the transaction was sent.

*  Start: The transaction start time.

*  Stop: The transaction stop time. If the transaction is currently running, the stop time is Null.

*  Diagram: A graphical depiction of the transaction consisting of a diamond and a series of
color-coded boxes connected by black or red lines. The diamond represents the inbound
document that contains the transaction. Each box represents a stage or task in the transaction
processing. The color of a particular box indicates the status of the task. Black lines indicate a
successful path between tasks. Red lines indicate a failure at some point between tasks.

*  Click Status Code Legend to open a window that lists the colors and their
corresponding color codes.

Click Refresh to refresh the transaction data displayed.

Click the INBOUND diamond to view the Inbound document that contains the transaction. See
Viewing Inbound/Outbound Document Data on page 3-4 for more information.

Click on one of the task boxes in the diagram to view payload data for the stage of the transaction.
You can view the payload data as either XML or HTML by selecting the appropriate option.
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Tasks Tab

The Tasks tab displays a list of the tasks associated with the transaction, including:

Payload: A link that opens a window displaying the payload of the task in either XML or
HTML.

Task Name: The name of the task.

Queue Name: The queue associated with the task.
Status: The current status of the task.

Start Time: Start time for the task.

Stop Time: Stop date for the task. If the transaction is currently running, the stop time is
blank.

Click Refresh to refresh the transaction data displayed.

Click on one of the task boxes in the diagram to view payload data for the stage of the transaction.
You can view the payload data as either XML or HTML by selecting the appropriate option.

Exceptions Tab

The Exceptions tab displays a list of exceptions associated with the transaction, including:

Exception Date: The date the exception occurred.

Source: The source of the exception (i.e. where the exception occurred).
ID: The ID of the exception.

Exception Type: The type of exception.

Exception Description: A description of the exception.

Exception Message: The exception message.

Click Refresh to refresh the transaction data displayed.

Notes Tab

The Notes tab displays notes related to the transaction.

To add a note, type the note in the Notes field and click Save.

To edit an existing note, edit the text in the Notes field and click Save.

Click Refresh to refresh the transaction data displayed.
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Search Requests/Responses

The Search Request/Response option allows users to search for http requests and responses in
the Oracle Utilities Data Repository based on various seatch criteria.

How to search request and responses:

1. Select Transaction Management->Search-Request/Response.

The Search Request/Response window opens.

To search archived requests or responses, check the Search Archive checkbox.
2. Select or enter the search criteria in the appropriate field.

You can select the Sender Name, Receiver Name, Payload Type, Status Code, or Request
Code associated with the request or response.

You can also search based on the date the request or response was sent by entering the dates
in the Request Date fields.

3. Select the manner in which the results are sorted from the Order By: drop-down list. You
can sort the results by Request Date or Status of the request or response.

4. Specify how many results should appear on each page in the Page Length field.

5. Click Search to begin the search. To reset all the fields to their default values, click Reset. To
clear all the fields, click Clear.

6. The seatch results appear in the Request/Response Search Results window.

The Request/Response Search Results window displays the following information for
each request or response:

*  Request
. Status
e Sender ID

*  Receiver ID

*  Document Reference ID
*  Payload Type

*  Total Transactions

*  Document ID

*  Document File Name

*  Document Received Date
*  Request Date

7. To sort the results by one of the columns, click the appropriate column heading. For example,
to sort the results by Status, click the Status column heading. If there is more than one page of
results, you can move between pages using the 4 and P buttons. To change the number of

results that appears on each page, enter the number in the Rows field.

8. To perform another search, click New Search. To refresh the contents of the Search Results
window, click Refresh.
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Search Document Downloads

The Search Document Downloads option allows users to search for document download
records in the Oracle Ultilities Data Repository based on various search criteria. You can also use

this screen to add new document download records.

How to search document downloads:

1.

Select Transaction Management->Search->-Document Download.
The Search Document Download window opens.
Select or enter the search criteria in the appropriate field.

You can select the Sender, Document ID, Document Name, Status Code, or Download Type
associated with the document download.

You can also search based on the date the document download was received by entering the
dates in the Receive Date Between fields.

Select the manner in which the results are sorted from the Order By: drop-down list. You
can sort the results by Request Date, Sender, or Status of the document download.

Specify how many results should appear on each page in the Page Length field.

Click Search to begin the search. To reset all the fields to their default values, click Reset. To
clear all the fields, click Clear.

The search results appear in the Document Download Search Results window.

The Document Download Search Results window displays the following information for
each document download:

*  Document ID

*  Document Name

*  Received Date

*  Sender

*  Status Code

*  Download Type

*  Exception Message

To sort the results by one of the columns, click the appropriate column heading. For example,
to sort the results by Status Code, click the Status Code column heading. If there is more than

one page of results, you can move between pages using the 4 and P buttons. To change
the number of results that appears on each page, enter the number in the Rows field.

To perform another search, click New Search. To refresh the contents of the Search Results
window, click Refresh.

To terminate one or more document downloads, check the checkbox for the document
downloads you wish to terminate, and click Terminate. The status code for each selected
record will be updated to “USER TERMINATED.”

How to add document downloads:

1.

Select Transaction Management->Search->Document Download.
The Search Document Download window opens.

Click Add.

The Search Document Download window opens.

Select the Sender for the document download record from the drop-down list.
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Enter a Document ID for the document download record.
Enter a Document Name for the document download record.
Enter a Receive Date for the document download record.

Click Save.
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Chapter 4

Searching and Viewing Exceptions

This chapter describes how to view Oracle Utilities Transaction Management system exceptions,
including:

*  Search Exceptions

*  System Exceptions
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Search Exceptions

The Search Exceptions option allows users to search for exceptions in the Oracle Utilities Data
Repository based on various search critetia.

How to search exceptions:

1. Select Transaction Management-»Search->Exceptions.
The Search Exceptions window opens.

2. Select the type of exception to search for by checking/unchecking the Inbound, Outbound,
Transaction, and/ot Request checkboxes.

3. Select or enter the search criteria in the appropriate field.
You can select the Sender or Receiver associated with the exception.

You can also search based on the Source by entering the appropriate value associated with the
process or transaction. Note that Sources are case-sensitive. For example, there is a
difference between the “USER_1" and “user_1”" Sources.

You can also search based on the date associated with the exception. To search based on the
date, enter the dates in the Exception Date ficlds.

4. Select the manner in which the results are sorted from the Order By: drop-down list. You
can sort the results by Exception Date, Exception Type, or Source of the exception.

5. Specify how many results should appear on each page in the Page Length field.
6. Click Search to begin the search. To reset all the fields to their default values, click Reset.
7. The search results appear in the Exceptions Search Results window.

The Exception Search Results window displays the following information for each
exception:

*  Exception Type

*  Source

*  Sender ID

*  Receiver ID

*  Exception Date

*  Exception Message

8. To sort the results by one of the columns, click the appropriate column heading. For example,
to sort the results by Source, click the Source column heading. If there is more than one page

of results, you can move between pages using the 4 and P buttons. To change the number
of results that appears on each page, enter the number in the Rows field.

9. To view a transaction, click on the view icon (a) Data for the selected transaction will
appeat in the Transaction window. See Viewing Transaction Data on page 3-11 for more
information.

10. To perform another search, click New Search. To refresh the contents of the Search Results
window, click Refresh.
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System Exceptions

The System Exceptions options allows users to view Oracle Utilities Transaction Management
system exceptions.

How to view System Exceptions:

1. Select Transaction Management->Search-System/Token Exceptions.
The System Exceptions window opens.
2. 'The System Exceptions window displays the following information for each exception:
*  Token: The transaction or process related to the exception.
*  Source: The source of the exception (i.e. where in the process the exception occurred)
*  Date: The date of the exception.

*  Message: A message that describes the exception.
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Chapter 5

Oracle Utilities Transaction Management Setup

This chapter describes the Oracle Utilities Transaction Management Setup menu, including:
*  Transaction Management Business Rules
*  Transaction Management Components

*  Transaction Management Setvices
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Transaction Management Business Rules

Global Functions

This section describes how you configure business rules used by Oracle Ultilities Transaction
Management, including:

*  Global Functions
*  Rule Description Language

*  Business Rules

Global functions are snippets of application code that can be used with multiple Rule Description
Language scripts. Each global function is related to a particular Business Rule Type (Import and
Import Interval), and is available during configuration of an RDL of the same Business Rule Type.

See Global Functions on page 11-50 in the Oracle Utilities Energy Information Platform User’s Guide
for information on working with global functions.

Rule Description Language

Business Rules

Rule Description Language (RDL) scripts define specific units of work for business rules. RDL
scripts describe what actions will be taken with an incoming payload, such as whether or not to
insert particular pieces of data into the Oracle Utilities Data Repository based on a set of
validations. RDL scripts are used only with Import, ImportInterval, and Interval Business Rule
Types.

See Rule Description Language on page 11-53 in the Oracle Utilities Energy Information Platform
User’s Guide for information on working with global functions.

Business rules are individual business rules that are available to Oracle Ultilities Transaction
Management. In specific, they define the business rules that will be applied to data being
processed Oracle Utilities Transaction Management.

Sec Business Rules on page 11-58 in the Oracle Utilities Energy Information Platform User’s Guide for
information on working with global functions.
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Transaction Management Components

Servers

JMS Servers

JMS Queues

Payload Types

Oracle Utilities Transaction Management utilize several components such as servers, Java
Messaging Service (JMS) servers, and other components. This section describes how to set up
records that define these components in the Oracle Utilities Data Repository, including:

*  Servers

*  JMS Servers

*  JMS Queues

*  Payload Types

*  Exception Types

*  Origination Systems

*  System Properties

*  Trading Partners

*  External Transaction Types
*  External Hubs

e  External Hub Activation

Servers are the application servers which run the Oracle Utilities Transaction Management
application. Only application servers with corresponding Server records can run the Oracle
Utilities Transaction Management/Oracle Utilities Adapter software.

See Servers on page 11-2 in the Oracle Utilities Energy Information Platform User’s Guide for
information on working with servers.

JMS Servers are Java Messaging Service (JMS) compliant components used by Oracle Utilities
Transaction Management. JMS Servers are linked to Servers in System Properties records. Note
that even if JMS Servers are not being used, a placeholder record is required.

See JMS Servers on page 11-4 in the Oracle Utilities Energy Information Platform User’s Guide for
information on working with JMS servers.

JMS Queues are message queues used by JMS compliant components used by Oracle Ultilities
Transaction Management. JMS Queues are associated to services in Runtime Service records.

See JMS Queues on page 11-5 in the Oracle Utilities Energy Information Platform User’s Guide for
information on working with JMS queues.

Payload types represent different payloads used by Oracle Ultilities Transaction Management
transactions. Payload types are used by the Oracle Ultilities Transaction Management Database
Portal to indicate which payload type to monitor.

See Payload Types on page 11-7 in the Oracle Utilities Energy Information Platform User’s Guide fot
information on working with payload types.
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Exception Types

Exception types represent different types of custom exceptions that can be generated by Oracle
Utilities Transaction Management. Exception types (and their corresponding severity types) are
used for grouping and reporting purposes.

See Exception Types on page 11-9 in the Oracle Utilities Energy Information Platform User’s Guide for
information on working with exception types.

Origination Systems

System Properties

Trading Partners

Origination Systems define the external data sources used by Oracle Utilities Transaction
Management, and indicate the system the transaction originated from. Origination Systems are
linked to services in Runtime Service records.

See Origination Systems on page 11-10 in the Oracle Utilities Energy Information Platforn User’s
Guide for information on working with origination systems.

System Properties represent specific Oracle Utilities Transaction Management servers at runtime,
defining how the Oracle Utilities Transaction Management server will perform. System property
records also link Servers with JMS Servers and provide basic information which the server needs
to run propetly.

See System Properties on page 11-12 in the Oracle Utilities Energy Information Platform User’s Guide
for information on working with system properties records.

Trading Partners represent any party to whom Oracle Utilities Transaction Management will send
and/or receive transactions.

How to search trading partners:

1. Select Transaction Management->SetUp-Trading Partners.
The Trading Partners screen opens.

2. Enter the search criteria in the appropriate field.

You can search based on the UID, ID, Name, Type, Inbound Directory, Inbound Extension,
Outbound Directory, Outbound Extension, or Hub (JMS) Queue of the trading partner(s).

See Searching Database Tables on page 8-7 for more information about searching records,
including the use of operands and wildcards.

3. Click Search to perform the search. To reset the search fields to their previous values, click
Reset. To clear all the seatch fields, click Clear. To add a new record, click Add. See Adding
Trading Partners on page 5-6 for more information about adding new trading partners.

4. 'The search results appear on the Trading Partners list screen.

The Trading Partners list screen displays the following information for each record:

« UID

« ID

* Name
* Type

* Inbound Directory

¢ Inbound Extension
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*  Outbound Directory
*  Outbound Extension
*  Hub (JMS) Queue

e UserID

*  Timestamp

See Viewing and Editing Trading Partners on page 5-5 for more information about
viewing individual records.

To sort the results by one of the columns, click the appropriate column heading. For example,
to sort the results by Type, click the Type column heading. If there is more than one page of

results, you can move between pages using the 4 and P buttons. To change the number of
results that appears on each page, enter the number in the Rows field.

To view a record, click on the corresponding [...] link. The selected record will appear in the
Trading Partners screen. See Viewing and Editing Trading Partners on page 5-5 for more
information.

To perform another search, click Search. To refresh the contents of the list screen, click the
refresh icon.

Optional. To delete one or more records, check the check boxes corresponding to the records
to be deleted, and click Delete. To clear all the checkboxes, click Cleat.

Optional. To add a new record, click Add. See Adding Trading Partners on page 5-6 for
more information about adding new trading partners.

Viewing and Editing Trading Partners

Individual trading partners are viewed on the Trading Partners screen. This screen opens when

you select a record from the Trading Partners list screen.

How to view and edit trading partners:

1.

Click on the [...] link for the trading partner you wish to view. The selected record opens in
the Trading Partners screen.

The Trading Partners screen displays the following information for the selected record:
*  UID: The unique identifier for the record in the Oracle Ultilities Data Repository.

e ID: The identifier for the trading partner. This should match the identifier present in
transaction documents, and is used to specifically identify the sender or receiver of a
transaction.

*  Name: The internal name for the trading partner.

*  Type: The type of trading partner. For example, the type of business in which the trading
partner primarily engages.

*  Inbound Directory: The directory in which the Oracle Utilities Transaction
Management FileLoader service locates incoming files sent by the trading partner. If the
“POLL_DIRECTORY” property is not defined, then the “TPID” (Trading Partner ID)
property must be defined. When the “TPID” property is defined, the polling directory is
pulled from this column based on the defined “TPID”.

* Inbound Extension: The file extension the Oracle Utilities Transaction Management
FileLoader service uses to select incoming files within the Inbound Directory. When the
“TPID” (Trading Partner ID) property is defined, the default file extension can be
replaced with the extension specified in this column.

*  Outbound Directory: The directory into which the Oracle Utilities Transaction
Management Outbound Gateway service will deposit files it produces for sending to the
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trading partner. If the service is setup to export data to files (the “EXPORT” property
equals “F” or “FQ”) and the “EXPORT_DIRECTORY” is not defined, then exporting
directory is pulled from this column based on the defined “TPID” (Trading Partner ID)
of the receiver.

*  Outbound Extension: The extension which the Oracle Utilities Transaction
Management Outbound Gateway service will append to files it produces for sending to
the trading partner. If the service is setup to export data to files (the “EXPORT”
property equals “F” or “FQ”) and the “EXPORT_DIRECTORY” is not defined, then
the exporting extension can be replaced from this column based on the defined “TPID”
(Trading Partner ID) of the receiver.

*  Hub (JMS) Queue: The queue into which the Oracle Utilities Transaction Management
Outbound Gateway service will send its output. (from the JMS Queues table). If the
service is setup to export data to a queue (the “EXPORT” property equals “Q” or
“FQ”) and the “EXPORT_QUEUE” property is not defined, then the exporting queue
is pulled from this column based on the defined “TPID” (Trading Partner ID) of the
receiver.

Edit data in the fields as appropriate. See Working with Data Types on page 8-4 for more
information about editing data values.

To save changes made to the record, click Save. To save the edited record as a new record,
click Save As New.

Note: The Save As New option only works if the identity of the record has been changed.
To perform a new search, click Search.

To open a list of records, click List.

To delete the current record, click Delete.

To navigate from the current record to one of its parent or lookup records, click the Name of
the parent table on the record. Parent and lookup records appear underlined on the screen.
Use the Back button to return to the record being viewed.

To view a list of child records, click the name of the child table you wish to view in the
Children section of the screen. Use the Back button to return to the record being viewed.

Adding Trading Partners

You can also add new trading partners.

How to add trading partners:

1.

Click Add on ecither the Trading Partners search or list screens. A blank Trading Partners
screen opens.

Enter the ID of the trading partner in the ID field. This should match the identifier present
in transaction documents, and is used to specifically identify the sender or receiver of a
transaction.

Enter the internal name of the trading partner in the Name field.
Enter the type of the trading partner in the Type field.

Enter the directory in which the Oracle Ultilities Transaction Management FileLoader service
locates incoming files sent by the trading partner in the Inbound Directory field.

Enter the file extension the Oracle Utilities Transaction Management FileLoader service uses
to select incoming files within the Inbound Directory in the Inbound Extension field.

Enter the directory into which the Oracle Utilities Transaction Management Outbound
Gateway service will deposit files it produces for sending to the trading partner in the
Outbound Directory field.
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Enter the extension which the Oracle Ultilities Transaction Management Outbound Gateway
service will append to files it produces for sending to the trading partner in the Outbound
Extension field.

Select the Hub (JMS) Queue into which the Oracle Utilities Transaction Management
Outbound Gateway service will send its output by clicking the Browse button ( ...). This
opens a dialog window that lists all the available Hub (JMS) Queues.

10. To save the record, click Save. The new trading partner appears on the screen.

External Transaction Types

External Transaction Types represent different transaction types used by Oracle Utilities

Transaction Management. External Transaction Types tie to the External transaction type that is

associated to each Oracle Utilities Transaction Management transaction. The Transaction

Identification service will generate an exception if the External Transaction Type associated with

an Oracle Ultilities Transaction Management transaction is not defined in this table.

How to search external transaction types:

1.

Select Transaction Management->SetUp>External Transaction Types.

The External Transaction Types screen opens.

Enter the search criteria in the appropriate field.

You can search based on the UID or External Transaction Type of the external transaction
type(s).

See Searching Database Tables on page 8-7 for more information about searching records,
including the use of operands and wildcards.

Click Search to perform the search. To reset the search fields to theit previous values, click

Reset. To clear all the search fields, click Clear. To add a new record, click Add. See Adding
External Transaction Types on page 5-8 for more information about adding new external
transaction types.

The search results appear on the External Transaction Types list screen.

The External Transaction Types list screen displays the following information for each
record:

« UID
*  External Transaction Type

See Viewing and Editing External Transaction Types on page 5-8 for more information
about viewing individual records.

To sort the results by one of the columns, click the appropriate column heading. For example,
to sort the results by External Transaction Type, click the External Transaction Type column
heading. If there is more than one page of results, you can move between pages using the 4
and P buttons. To change the number of results that appears on each page, enter the

number in the Rows field.

To view a record, click on the corresponding [...] link. The selected record will appear in the
External Transaction Types screen. See Viewing and Editing External Transaction Types
on page 5-8 for more information.

To perform another search, click Search. To refresh the contents of the list screen, click the
refresh icon.

Optional. To delete one or more records, check the check boxes corresponding to the records
to be deleted, and click Delete. To clear all the checkboxes, click Cleat.
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Optional. To add a new record, click Add. See Adding External Transaction Types on page
5-8 for more information about adding new external transaction types.

Viewing and Editing External Transaction Types
Individual external transaction types are viewed on the External Transaction Types screen. This

screen opens when you select a record from the External Transaction Types list screen.

How to view and edit external transaction types:

1.

N vk

Click on the [...] link for the external transaction type you wish to view. The selected record
opens in the External Transaction Types screen.

The External Transaction Types screen displays the following information for the selected
record:

*  UID: The unique identifier for the record in the Oracle Utilities Data Repository.
*  External Transaction Type: The name of the external transaction type.

Edit data in the fields as appropriate. See Working with Data Types on page 8-4 for more
information about editing data values.

To save changes made to the record, click Save. To save the edited record as a new record,
click Save As New.

Note: The Save As New option only works if the identity of the record has been changed.
To perform a new search, click Search.

To open a list of records, click List.

To delete the current record, click Delete.

To navigate from the current record to one of its parent or lookup records, click the Name of
the parent table on the record. Parent and lookup records appear underlined on the screen.
Use the Back button to return to the record being viewed.

To view a list of child records, click the name of the child table you wish to view in the
Children section of the screen. Use the Back button to return to the record being viewed.

Adding External Transaction Types
You can also add new external transaction types.

How to add external transaction types:

1.

Click Add on ecither the External Transaction Types search or list screens. A blank External
Transaction Types screen opens.

Enter the name of the external transaction type in the External Transaction Type field.

To save the record, click Save. The new external transaction type appears on the screen.
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External Hubs

External Hubs represent external systems to/from which Oracle Utilities Transaction

Management sends/receives transactions.

How to search external hubs:

1.

Select Transaction Management->SetUp->External Hubs.
The External Hubs screen opens.
Enter the search criteria in the appropriate field.

You can search based on the External Hub ID, Hub Name, Hub Type, URL, or
Authentication method of the external hub(s).

See Searching Database Tables on page 8-7 for more information about searching records,
including the use of operands and wildcards.

Click Search to perform the search. To reset the search fields to theit previous values, click
Reset. To clear all the search fields, click Clear. To add a new record, click Add. See Adding
External Hubs on page 5-10 for more information about adding new external hubs.

The search results appear on the External Hubs list screen.
The External Hub list screen displays the following information for each record:

¢ External Hub ID

¢ Hub Name
*  Hub Type
« URL

¢ Authentication Method

See Viewing and Editing External Hubs on page 5-9 for more information about viewing
individual records.

To sort the results by one of the columns, click the appropriate column heading. For example,
to sort the results by External Hub ID, click the External Hub ID column heading. If there is

more than one page of results, you can move between pages using the 4 and P buttons. To
change the number of results that appears on each page, enter the number in the Rows field.

To view a record, click on the corresponding [...] link. The selected record will appear in the
External Hubs screen. See Viewing and Editing External Hubs on page 5-9 for mote
information.

To perform another search, click Search. To refresh the contents of the list screen, click the
refresh icon.

Optional. To delete one or more records, check the check boxes corresponding to the records
to be deleted, and click Delete. To clear all the checkboxes, click Cleat.

Optional. To add a new record, click Add. See Adding External Hubs on page 5-10 for more
information about adding new external hubs.

Viewing and Editing External Hubs

Individual external hubs are viewed on the External Hubs screen. This screen opens when you

select a record from the External Hubs list screen.

How to view and edit external hubs:

1.

Click on the [...] link for the external hub you wish to view. The selected record opens in the
External Hubs screen.

The External Hubs screen displays the following information for the selected record:
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*  External Hub ID: The ID for the external hub
*  Hub Name: The name of the external hub

*  Hub Type: The type of hub

e URL: The URL of the external hub

*  Authentication Method: The authentication method used when accessing the external
hub via Oracle Utilities Transaction Management

Edit data in the fields as appropriate. See Working with Data Types on page 8-4 for more
information about editing data values.

To save changes made to the record, click Save. To save the edited record as a new record,
click Save As New.

Note: The Save As New option only works if the identity of the record has been changed.
To perform a new search, click Search.

To open a list of records, click List.

To delete the current record, click Delete.

To navigate from the current record to one of its parent or lookup records, click the Name of
the parent table on the record. Parent and lookup records appear underlined on the screen.
Use the Back button to return to the record being viewed.

To view a list of child records, click the name of the child table you wish to view in the
Children section of the screen. Use the Back button to return to the record being viewed.

Adding External Hubs

You can also add new external hubs.

How to add external hubs:

1.

AN A T

Click Add on either the External Hubs search or list screens. A blank External Hubs screen
opens.

Enter an ID for the external hub in the External Hub ID field.
Enter the name of the external hub in the Hub Name field.
Enter the type of hub in the Hub Type field.

Enter the URL of the external hub in the URL field.

Enter the authentication method used to connect to the external hub in the Authentication
Method field.

To save the record, click Save. The new external hub appears on the screen.

External Hub Activation

External Hub Activation records provide specifics surrounding the activation of external hubs

accessed Oracle Ultilities Transaction Management.

How to search external hub activation records:

1.

Select Transaction Management->SetUp-»External Hub Activation.
The External Hub Activation screen opens.
Enter the search criteria in the appropriate field.

You can search based on the External Hub ID, Trading Partner, Request Interval, UserName,
Password, Timezone, or Enabled flag of the record.

5-10 Transaction Management User’s Guide



See Searching Database Tables on page 8-7 for more information about searching records,
including the use of operands and wildcards.

Click Search to petform the search. To reset the search fields to theit previous values, click
Reset. To clear all the search fields, click Clear. To add a new record, click Add. See Adding
External Hub Activation Records on page 5-12 for more information about adding new
external hub activation records.

The search results appear on the External Hub Activation list screen.

The External Hub Activation list screen displays the following information for each record:
*  External Hub

*  Trading Partner

*  Request Interval

e Username

*  Password

* Timezone

*  Enabled flag

See Viewing and Editing External Hub Activation Records on page 5-11 for more
information about viewing individual records.

To sort the results by one of the columns, click the appropriate column heading. For example,
to sort the results by External Hub, click the External Hub column heading. If there is more
than one page of results, you can move between pages using the 4 and P buttons. To

change the number of results that appears on each page, enter the number in the Rows field.

To view a record, click on the corresponding [...] link. The selected record will appear in the
External Hub Activation screen. See Viewing and Editing External Hub Activation
Records on page 5-11 for more information.

To perform another search, click Search. To refresh the contents of the list screen, click the
refresh icon.

Optional. To delete one or more records, check the check boxes corresponding to the records
to be deleted, and click Delete. To clear all the checkboxes, click Cleat.

Optional. To add a new record, click Add. See Adding External Hub Activation Records
on page 5-12 for more information about adding new external hub activation records.

Viewing and Editing External Hub Activation Records
Individual external hub activation records are viewed on the External Hub Activation screen. This

screen opens when you select a record from the External Hub Activation list screen.

How to view and edit external hub activation records:

1.

Click on the [...] link for the record you wish to view. The selected record opens in the
External Hub Activation screen.

The External Hub Activation screen displays the following information for the selected
record:

¢ External Hub: The ID for the external hub

*  Trading Partner: The trading partner associated with the external hub, from the
Trading Partners table.

*  Request Interval: The interval at which requests are sent to the external hub

¢ Username: The user name used to access the external hub
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*  Password: The password used to access the external hub
* Timezone: The time zone in which the external hub is located

*  Enabled: A flag that designates if the external hub is enabled for access via Oracle
Utilities Transaction Management

Edit data in the fields as appropriate. See Working with Data Types on page 8-4 for more
information about editing data values.

To save changes made to the record, click Save. To save the edited record as a new record,
click Save As New.

Note: The Save As New option only works if the identity of the record has been changed.
To perform a new search, click Search.

To open a list of records, click List.

To delete the current record, click Delete.

To navigate from the current record to one of its parent or lookup records, click the Name of
the parent table on the record. Parent and lookup records appear underlined on the screen.
Use the Back button to return to the record being viewed.

To view a list of child records, click the name of the child table you wish to view in the
Children section of the screen. Use the Back button to return to the record being viewed.

Adding External Hub Activation Records

You can also add new external hub activation records.

How to add external hub activation records:

1.

S AT o

Click Add on either the External Hub Activation search or list screens. A blank External Hub
Activation screen opens.

Select the external hub in the External Hub field.

Select the trading partner associated with the external hub in the Trading Partner field.
Enter the request interval for the external hub in the Request Interval field.

Enter the user name used to access the external hub in the Username field.

Enter the password used to access the external hub in the Password field.

Enter the time zone in which the external hub is located in the Timezone field.

Indicate if the external hub is enabled (Yes or No) from the Enabled? drop-down list.

To save the record, click Save. The new external hub activation record appears on the screen.
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Transaction Management Services

Services are the basic working components of Oracle Ultilities Transaction Management. A service
does a single unit of work, a series of which can be chained together in processing transactions.
This section describes how to set up records that define these services in the Oracle Utilities Data
Repository, including:

*  Runtime Services

*  Service Activation

*  XSLT Map Names

*  XSLT Map Versions
*  XSLT Maps

Runtime Services

Runtime Services represent individual Oracle Utilities Transaction Management services. When
used with JMS, Runtime Services take input from JMS Queues.

See Runtime Services on page 11-16 in the Oracle Utilities Energy Information Platform User’s Guide
for information on working with runtime services.

Service Activation

Service Activation records define how individual Oracle Utilities Transaction Management
services will run on each server. Service Activation records link specific Servers to Runtime
Services.

See Service Activation on page 11-20 in the Oracle Utilities Energy Information Platform User’s Guide
for information on working with service activation records.

XSLT Map Names

XSLT Map Names are names and descriptions of XML stylesheets (or maps) used by Oracle
Utilities Transaction Management. XSL'T Maps Names are used to define XSLT Map Versions.

See XSLT Map Names on page 11-22 in the Oracle Utilities Energy Information Platform User’s Guide
or Maps on page 4-16 in the Oracle Utilities Transaction Management User’s Guide for information on
working with XSL'T map names.

XSLT Map Versions

XSLT Map Versions represent specific versions of XML stylesheets (or maps) used by Oracle
Utilities Transaction Management. Adapter. XSLT Maps Versions ate used to define XSLT Maps.

See XSLT Map Versions on page 11-23 in the Oracle Utilities Energy Information Platform User’s
Guide or Maps on page 4-16 in the Oracle Utilities Transaction Management User’s Guide for
information on working with XSLT map versions.

XSLT Maps

XSLT Maps are records which store the actual XML stylesheets (or maps) used by Oracle Utilities
Transaction Management. XSL'T Maps are defined by XSLT Map Versions.

See XSLT Maps on page 11-26 in the Oracle Utilities Energy Information Platform User’s Guide ot
Maps on page 4-16 in the Oracle Utilities Transaction Management User’s Guide for information on
working with XSLT maps.
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Chapter 6

Oracle Utilities Transaction Management
Reports

This chapter describes the reports provided with Oracle Utilities Transaction Management,
including:

*  Transaction Details Report
*  Exception Details Report

*  Transaction Control Report
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Transaction Details Report

The Transaction Details Report lists details related to transactions in the Oracle Utilities Data
Repository based on specified criteria.

How to run the Transaction Details Report:

1. Select Transaction Details on the Run Reports screen. The Transaction Detail screen
opens.

2. Select or enter the report criteria in the appropriate field.

The Report Title ficld is the title that appears on the View Reports screen when the report
is run.

You can select the Process Type, Process Name, Transaction Type, Transaction Name, Status
Code, Sender, or Receiver from the drop-down lists.

You can also report based on Internal Acct#, or External Acct#, or Trans Ref ID by entering
the appropriate value. Note that Sender IDs, Receiver IDs, REF IDs, Internal Acct#s, and
External Acct#s are case-sensitive. For example, there is a difference between the
“USER_1” and “user_1" Sender IDs.

You can also report based on dates by entering dates in the Date Sent fields.

You can use an asterisk (“*”’) as a wildcard character when entering values in any of the text
fields. For instance, if you want a report to include all Account IDs that begin with the letter
G, you could enter “G*” in the Account ID field. You can use this wildcard before or after
specified letters or numbers (i.e. you would use *t to include all Account IDs that end with
the letter t, etc.).

3. Uncheck the Shared Report checkbox if you wish to make the results of the report private. If
you leave this checkbox checked, the report results will be available to all users.

4.  Click Run to run the report.
5. The report appears in a report window.

Once run, Transaction Detail reports are also available from the Reports List. See View Reports
on page 2-12 for more information.
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Exception Details Report

The Exception Details Report lists details related to exceptions in the Oracle Utilities Data
Repository based on specified criteria.

How to run the Exception Details Report:

1.
2.

4.
5.

Select Exception Details on the Run Reports screen. The Exception Detail screen opens.
Select or enter the report criteria in the appropriate field.

The Report Title field is the title that appears on the View Reports screen when the report
is run.

You can select the Process Type, Process Name, Transaction Type, Transaction Name, Status
Code, Sender, or Receiver from the drop-down lists.

You can also report based on Internal Acct#, or External Acct#, or Trans Ref ID by entering
the appropriate value. Note that Sender IDs, Receiver IDs, REF IDs, Internal Acct#s, and
External Acct#s are case-sensitive. For example, there is a difference between the
“USER_1” and “user_1" Sender IDs.

You can also report based on dates by entering dates in the Date Sent fields.

You can use an asterisk (“*”’) as a wildcard character when entering values in any of the text
fields. For instance, if you want a report to include all Account IDs that begin with the letter
G, you could enter “G*” in the Account ID field. You can use this wildcard before or after
specified letters or numbers (i.e. you would use *t to include all Account IDs that end with
the letter t, etc.).

Uncheck the Shared Report checkbox if you wish to make the results of the report private. If
you leave this checkbox checked, the report results will be available to all users.

Click Run link to run the report.

The report appears in a report window.

Once run, Exception Detail reports are also available from the Reports List. See View Reports on

page 2-12 for more information.
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Transaction Control Report

The Transaction Control Report lists all the transactions processed by Oracle Utilities Transaction

Management within a given date range.

How to run the Transaction Control Report:

1.

6.

Select Transaction Control on the Run Reports screen. The Enter Report Parameters
screen opens.

Enter a Report Title for the report. This is the title that appears on the View Reports screen
when the report is run.

Enter the date range for the report.

You can change the dates either by typing the date manually, or by clicking the drop-down
arrow to the right of the date field. This opens a calendar dialog that you can use to select the
correct dates for the report. You change the time by typing the time manually.

Uncheck the Shared Report checkbox if you wish to make the results of the report private. If
you leave this checkbox checked, the report results will be available to all users.

Click Run to run the report. Click Schedule to schedule the report. See View Reports on
page 2-12 for more information about scheduling reports.

The report appears in a report window.

Once run, Transaction Control reports are also available from the Reports List. See View Reports

on page 2-12 for more information.
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